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GalilSuite
GalilSuite is the primary software package for Galil Motion Controllers and PLCs.

Figure 1: GalilSuite connected to a controller showing just four of the many development tools available.

Software Details

Technical Specifications

Supported Controllers
DMC40x0
DMC41x3
DMC30010
DMC21x3/2
RIO47xxx
DMC18x6 - PCI Driver required, separate installer
DMC18x0 - PCI Driver required, separate installer
DMC18x2* - PCI Driver required, separate installer

Contact Galil for other hardware products
Supported Operating Systems**

Microsoft Windows 8
Microsoft Windows 7
Microsoft Windows XP SP3

Scope, Watch, and Viewer support require an Ethernet or PCI connection and controller firmware supporting the DR command

* No Scope, Watch, or Viewer support.
** Contact Galil for other OS options.

Communications Service

GalilSuite uses a communications server to optimize traffic to and from Galil hardware. By default, the GalilSuite installer will
install and set the service to start by default when Windows boots. If a service is not desirable, the installer also provides a system
tray server application that can be run in the service's place. To switch off the service and use the tray, follow the steps below for
Windows 7.

1. Click Start -> Run, type services.msc and click OK.
2. Click the "Standard" tab if necessary.
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3. Find "Galil Service" in the alphabetical listing.
4. Right-click "Galil Service" and choose Properties.
5. Under the General tab change "Startup type" from "Automatic" to "Manual".
6. Click "Stop" under "Service status".
7. Once the service stops, click Apply, followed by OK.
8. Navigate to the GalilSuite installation directory, probably c:\Program Files\Galil\GalilSuite\ or c:\Program Files

(x86)\Galil\GalilSuite\
9. Run SvrTrayLoader.exe

10. The tray service will start. In the task bar, right click the Galil logo to stop or exit the tray application. When the server is
started, the logo will be in color. A stopped server will be grayscale.

11. Use GalilSuite normally.
12. The tray application will need to be manually started in the future.

Figure 2: GalilSuite Tray Icon used instead of service.

Legal

Copyright 2013, Galil Motion Control
GalilSuite is based in part on the work of the Qwt project (http://qwt.sf.net)
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The Launcher Toolbar
The Launcher is the main GalilSuite window that allows the user to manage tools, connections, settings, and custom user profiles.
It is a basic tool-bar-type application that uses tabs to organize multiple-connections and icons to launch Tools, such as the
Terminal and Scope. The user can switch between large and compact icons in the Launcher Toolbar Preferences window.

Figure 1: The GalilSuite Launcher window with two open connections displayed.

Launcher Layout

As shown in the image below, the Launcher's icons are aggregated together based upon their function. The various sections are
listed below.

Connection Tabs - Shows all open connections to Galil controllers.
Connection Options - Manages the connection settings for the currently selected Connection Tab.
Tools Launcher - Opens the various GalilSuite Tools
Windows Manager - Organizes windows into preset options, and manages custom Profiles.
Preferences and Help - Accesses the Preferences and Help windows.
Close and Minimize - Pressing these icons will close/minimize the GalilSuite Launcher and all open Tools.

Figure 2: Image showing the Launcher layout of various functions.

Each of the functions described above are provided in detail below including icon descriptions, functions, and GUI tips.

Connection Options

Icons

Icon Name Description

Connect Opens the "Device List" which allows the user to open a connection to a controller. For a detailed explanation of
the connection options see the "Establishing Connection" section below.

Disconnect Disconnects the currently selected tab's connection

Refresh
Connection

Pressing this resets the currently selected connection. This is useful after a power cycle or external reset to the
controller.

Abort
Sends the Abort (AB) command to the currently selected connection. The behavior of AB is dependent on the
controller type and the state of the OE (off on error) command. For more details, see the Command Reference
and Manual for your particular controller.

Table 1: Icon description for the various connection options

Establishing Connection

For users of Ethernet connections, the following links may be helpful.

Windows 7 Firewall Exceptions
Video: Connecting to Ethernet Controllers

When the Connect icon is clicked, a "Device List" window will open up to display all available Ethernet, RS-232 and PCI
connections. When ready to connect, the user will simply select the desired device/connection and hit the "Connect" button. If the
user would like to connect using custom options they would click the "Advanced" button instead.

If connecting via RS232 or USB using a different Baud rate than the default 115200 Baud, the user must either use the Advanced
Options or create a new Bookmark with the required Baud rate.
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Figure 3: Device List showing all possible connections available.

Assigning an IP Address

If the user selects an Ethernet controller that has yet to have an assigned IP address, they are prompted to do so with the
following window. GalilSuite will partially recommend an IP address based upon the sub net mask and IP address of the PC NIC
card. The user simply needs to specify the values for the IP address that GalilSuite has not automatically specified and click
"Assign" button when completed.

Figure 4: Prompt for the user to assign an IP address to an unassigned Accelera DMC-40x0 controller.

Advanced Options

Below is a list describing the functions of each of the advanced options for a Galil Ethernet, RS-232 or PCI controller.

Figure 5: Advanced Options when an Ethernet connection is selected.

Secondary Channel
If enabled, and connecting via Ethernet, GalilSuite will connect with two UDP ports per one controller. One UDP port is
used for "main" communication, including solicited commands and responses. The second UDP port will handle
unsolicited messages, user interrupts, and data record information. Disabling the secondary channel will disable the DR,
EI, and CF options described below. These options are required for certain GalilSuite Tools to function such as Watch,
Viewer and Scope.
For a PCI card this option simply disables the DR, EI, and CF features listed below.

Enable and reroute Data Record (DR)
If enabled, data record information (DR) will be sent as an unsolicited message to GalilSuite. Disabling this will prevent
GalilSuite from sending "DR." Some GalilSuite Tools require the use of the DR such as the Watch, Viewer and Scope.
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Enable and reroute Interrupt (EI)
If enabled, GalilSuite will re route and receive all user interrupts. Unchecking this box disables this feature.

Route Message to client (CF)
Unsolicited messages that are sent from embedded code within the controller (such as MG messages) are automatically
rerouted to GalilSuite upon connection. Unchecking this box disables this feature.

Log communication
Saves controller traffic to log. Log files are located at: C:\ProgramData\GalilSuite

When connecting to a serial connection the user can change the default Baud rate of their communication port, if required, as
well as the Route Message to client (CF) setting. The Secondary channel, DR and EI settings do not apply to serial RS232/USB
connections.

Bookmarks

Bookmarks allows a user to name a connection, and to save their advanced options for a particular connection for repeated use.
Once saved, this bookmark will be available each time the Connect Icon is selected. A bookmark is created by selecting a
connection you would like to save and pressing the "Bookmark" option. The user is then allowed to set a name for the Bookmark,
modify Advanced settings and edit the connection string. After these options are set, press the "Save" button. 

If you would like to edit an existing bookmark, select the bookmark in the Connection Window and press "Bookmark". 

If a connection is not selected before creating a Bookmark, the user will also have to specify the connection type
manually(Ethernet IP address, COM port and baud rate, or PCI card).

Figure 6: Bookmark options available to a selected Ethernet connection.

Connection Tabs (Managing Multiple Connections)

Connection Tabs allow for multiple connections to several controllers at once. Each tab represents a single connection and can be
clicked to select that connection as the "Active" connection. If Tools are open, their connection tabs will automatically be changed
to display the information for whichever tab is selected in the Launcher.

From the Launcher the user simply needs to press the "+" to create a new tab which can be used to connect to a new controller.
The "Device List" will automatically open allowing the user to select the connection of choice.
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Figure 7: Connection tabs are shown from the Launcher as well as in the Terminal Tool.

Connection Tabs in Tools

Similar to the Launcher, individual tools also have their own connection tabs. Each time a new Tool is opened, whatever
connection/s is open in the Launcher will be automatically opened in the Tool. When selecting a tab in a Tool, no change to the
active tab in the Launcher or any other Tool will occur.

Tool connection tabs can be un-docked by clicking-and-dragging a connection tab from the Tool. This allows the user to see
multiple connections to one Tool side-by-side if desired. To re-dock the Tool the user simply needs to click the "Dock to Window"
button as shown in the Figure above.

Figure 8: A connection tab that has been un-docked from the main Terminal Tool. Click the "Dock to Window" icon to reattach it.

Tools Launcher

Icons

Icon Name Description

Terminal The Terminal tool allows the user to send DMC commands to the controller and monitor unsolicited messages.
The terminal can also be used for basic program and array upload/download.

Editor
The Editor offers an advanced DMC file programming environment which includes auto-filling, syntax
highlighting, projects, and various other capabilities.

Viewer
The Viewer provides a basic graphical interpretation of the Data Record (DR) including the state of an Axis,
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Viewer I/O, etc.

Scope The Scope provides real-time state of data sources such as the current motor position, axis error, IO status,
etc. in a graphical form.

Watch The Watch allows the user to see variables, arrays, and parameters of the controller update in a list form.

Tuner The Tuner provides both manual and automatic tuning options. Automatic tuning options include Crossover,
General, and Curve Follower methods.

Configuration
The Configuration tool provides the user a way to see the current parameters, settings, and configuration
state of the controller. It also allows the user to save, store, and download configuration options for easy
"cloning" of controllers.

Data Source
Data Source is used in conjunction with the Scope and Watch tool to provide the list of view-able data sources.
This allows the user to click-and-drag information from several connections into the Scope or Watch window
for viewing.

Table 2: Icon descriptoins for the Tools Launcher

The Tools Launcher icons listed above open the various tools available in GalilSuite. Clicking the Tools Launcher icon for an already
opened Tool will bring the Tool to the foreground.

Windows Management

Icons

Icon Name Description

Cascade All open Tools are lined up under the Launcher window in a Cascade format. Each window header is visible with this
option.

Stack All open Tools are placed in a single stack under the Launcher window.

Side by
Side

All open Tools are placed in two stacks side-by-side beneath the Launcher window. The Terminal and Data Source
Tool are placed next to all other Tools when this is pressed.

Profiles Profiles allows the user to choose a custom window configuration and connection setup when first opening
GalilSuite. Several profiles can be created for different users or for different development preferences.

Table 3: Descriptions of the various windows management options. 

The Windows Management icons provide a way to manage multiple open Tools at once. Pressing one of the icons organizes all
open Tools into preset window configurations shown below.

Figure 9: Cascade window configuration.
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Figure 10: Stack window configuration.

Figure 11: Side-by-side window configuration.
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The Terminal Tool
The terminal is used to send Galil commands to the controller and receive message output from the controller.

Figure 1: The Terminal tool showing an active connection tab, terminal traffic in the input pane, and messages in the Message Output pane.

Tool Details

The Terminal is broken into two panes. The top pane is for command-and-response. Valid Galil commands can be entered into this
window and the controller will respond back after the user types the "Enter" key. If the controller responds with a "?" response,
send "TC 1" to determine the command error.

The bottom pane is used to display asynchronous data sent from the controller such as messages (MG) and interrupts (EI/UI).

DMC Auto Complete

If this option is selected in the "View" menu, as the user types DMC code will be suggested from the controller's command set.

DMC Helper

The DMC Helper tool is enabled from the "View" menu. It provides graphical, menu-driven command syntax help. See more in the
DMC Helper documentation.
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Figure 2: The terminal provides a DMC Helper Tool for writing DMC code.

Command Reference Linking

The terminal will link to the help tool to provide realtime command reference lookups while you type. To open the help tool,
choose the menu "Help | Terminal Help." Now when commands are typed into the terminal, the Help tool will automatically
update to display the help information.

Message Output

The controller has the capability to send data asynchronously. This usually comes from the use of the "MG" command in
embedded code, but can also come from commands in embedded code which return information, such as TB, or from a runtime
error. This data will be printed in the Message Output window.

Some products have the capability to send interrupts, either through the PCI bus or over UDP. Consult your model's command
reference for commands UI and EI for more information. Interrupt data will also be displayed in the Message Output window.

Find Utility

The Find utility allows the user to search either the Input pane or the Message Output pane for specific text. Choose "Terminal"
from the combo box or "Message Output" to search the appropriate window. "Case Sensitive" searches the exact case of your
input string. "Entire Word" ensures that the string is not a substring in a larger word. The back and forward arrow determine the
direction of the search.

The Find utility can be closed with the "X" and opened from the Edit menu.

Menus

File
Log to file - provides a file chooser to create a new log file and turns on logging. Selecting again stops logging. Both the
Input pane and the Message Output pane are logged. Old logs with the same filename are overwritten, not appended.
Exit - Closes the Terminal tool.

Edit
Find - Displays the Find utility to search either the Input or Message Output pane.
Clear Terminal - Clears the text out of the Input pane.
Clear Message - Clears the text out of the Message Output pane.

View
DMC Helper - Shows or hides the DMC Helper utility.
DMC Auto Complete - Enabled or disables the Auto Complete feature which suggests command syntax as the user
types.

Terminal
Preferences - Opens the preferences dialog.

Help
Terminal Help - Opens this help document in the help viewer.
Galil Suite Help - Opens the help viewer to the GalilSuite main page.
Email Support - Provides a link to send email to Galil's support team. Report bugs or other problems here.
Provide Feedback - An alternative method to send a message to Galil that doesn't require an email client.
www.galilmc.com - Opens Galil's webpage.
About - Displays version information for GalilSuite.

Toolbar
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Icon Name Description

CAP LOCK
When enabled, all characters typed into the Input pane will be in caps, regardless of the Caps Lock
keyboard key.

Auto Repeat
Command

When enabled, the last command typed is put into a loop which is sent repeatedly to the controller. The
repeat rate is settable in preferences.

Program
Download Opens a file chooser and downloads the chosen dmc file to the controller's program memory.

Program Upload Opens a file chooser and uploads the controller's program memory to the chosen file.

Download Array Sends a csv file to the controller's array table.

Upload Array Saves the controller's array table to a csv file.

Table 1: Describes icons available in toolbar.
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The Editor Tool
The Editor Tool allows a user to work with Galil DMC files. Programs can be created, uploaded/downloaded to the controller,
executed, and saved to a file.

Figure 1: The Editor tool is the main tool for developing and running application code on your controller.

Tool Details

Program Edit window

The Program Edit window is the main window of the Tool which displays a DMC program. DMC programs can be edited here,
downloaded to a controller, or a new program can be uploaded from a controller to the window. Several programs at one time
can be accessed through tabs. Each tab displays a different .dmc file. The Line #: Column # indicator at the bottom right corner of
the tool shows where cursor is located in the current file. 

The Label Locator shown in the image below is a helpful drop down at the top of the Edit window that will automatically populate
itself with any labels that it detects in the code. Labels need to be at the beginning of the line and start with a # sign to be valid.
The Label Locator will jump to the label in your program when the users chooses one from the drop down menu. 

The syntax-highlighting feature of the Editor displays different colors based on whether the command is understood by the Editor.
For example, the syntax highlighting shows the difference between a command and a comment by displaying the command in
purple and the comment in green. The coloring of code does not necessarily mean that the code is going to run correctly but it can
sometimes help to see when a syntax error is made. 

A document can be sent from one file tab to another connection by right clicking on the file tab. This is useful if a document is open
under the wrong connection.
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Figure 2:This image shows the various components that make up the program edit section of the Editor Tool.

Project Explorer

Programs are saved to individual .dmc files. A project is a collection of .dmc files that are linked together. Using a project allows
users to concatenate multiple .dmc files into one program to be downloaded to the controller. This can be thought of similar to
what an "INCLUDE" statement does in higher level programming languages. 

The "Project Explorer" allows users to manage a project and the .dmc files associated with it. When working with Projects, users
can create a new project or open an existing project. This can be accomplished via the File Menu or from right clicking in the
empty space of the Project Explorer Window.

Figure 3: The Project explorer showing the right-click menu.

To add a .dmc program into a project, the user should first save the .dmc program. To add a .dmc file to a project that is already
open, drag and drop the .dmc program tab to the desired project. To add a .dmc file to a new project, drag and drop the .dmc
program tab to a blank area in the project explorer. Another way to add existing .dmc programs to existing projects is to right click
on the project then select Add existing files. To remove a file from a project, right click on the name of the .dmc program in the
Project Explorer then click Remove file. 
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The Project Properties dialog box will come up and allow you to choose the desired properties of the project such as whether the
programs need to be compressed, and whether white spaces or comments should be removed. The order of the files in the
window is how they will be combined and downloaded into the controller. To change the order, click on the file and use the arrow
buttons on the right-hand side to move it up or down.

Figure 4: The Project Property window is where project configuration settings are displayed.

Compression Description

Remove blank lines - Blank lines will be removed to save space.
Remove leading spaces - Leading spaces will be removed.
Remove comments - Comments (') will be removed.
Remove NO - No-Ops (NO) will be removed.
Compact lines - Code will be concatenated to fill line width.
Use tick - Where supported, the back tick (`) will be used to optimize compression.

DMC Helper

The DMC Code Helper is displayed on the right hand side of the screen and gives the user a quick reference tool organized by
command categories for finding and entering Galil commands including helping the user with the command syntax. Click here for
more information on this tool.

Output window

The Output Window displays Output Notifications such as when a program/project has been downloaded or an error has occurred.
To view unsolicited messages from your program, open the Terminal tool to see them in that tools Message Output window.

Command Help

The editor will link to the Help tool to provide real time command reference look ups while you type. To open the Help tool, choose
the menu "Help | Editor Help." Now when commands are typed into the terminal, the Help tool will automatically update to
display the help information.

Menus

File
New DMC File/Project - Creates a new .dmc file as a tab or a new project file (.mcp) in the Project Explorer.
Open DMC File/Project - Opens an existing DMC file in a new tab or an existing project file in the Project Explorer.
Close Project - Closes the currently active Project indicated in BOLD text in the Project Explorer.
Close All Projects - Closes all open projects in the Project Explorer.
Save - Saves changes to your current DMC program. This is greyed out if the file currently has no unsaved changes.
Save As - Saves changes to your current DMC program as a newly named file
Save All - Performs a "Save" on all open program tabs.
Close - Closes your current DMC program tab. A prompt will be displayed allowing the user to save any changes if
needed.
Close All - Closes all open program tabs. A prompt will be displayed allowing the user to save any changes if needed.
Print - Prints the currently open program tab. This prints just the text information in the file.
Exit - Closes the Editor tool

Edit
Undo - Allows you to reverse a previous action in the program window.(CTRL+Z)
Redo - Allows you to re-do a previous action that had been removed due to using the 'Undo' function.
Cut - Removes the highlighted text and puts it in the clipboard where it can be re added to the Program Edit window
using the Paste function. (CTRL+X)
Copy - Copies the highlighted text to the clipboard where it can be re added to the Program Edit window using the
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Paste function. (CTRL+C)
Paste - Takes the last text to be cut/copied and places it in the Program Edit window at the current cursor location.
(CTRL+V)
Select All - Selects all text in the currently open DMC file in the Program Edit window. (CTRL+A)
Find and Replace - Displays the Find and Replace utility to search the Program Edit window for text and replace it with
different text.(CTRL+F)
Project Property - Opens the property window for the currently active project. This is where you can select the build
order for files in your project, set the name of your output DMC file object(.dmo), and set compression style.

View
DMC Helper - Shows or hides the DMC Helper utility.
DMC Auto Complete - Enabled or disables the Auto Complete feature which suggests command syntax as the user
types.
Project Tab - Shows or hides the Project Explorer.
Output - Shows or hides the Output window.

Editor
Download Project - Downloads the currently active project to the controller. The Project Property window sets the
download behavior.
Download Program - Downloads the currently open DMC program to the controller.
Upload Program - Uploads the program currently loaded in the DMC controller and opens it in a new tab in the Program
Edit window.
Download Array - Sends a .csv file to the controller's array table.
Upload Array - Saves the controller's array table to a .csv file.
Execute Program - Sends the "XQ" command to the controller to start program execution.
Stop Program - Sends the "ST" command to the controller to stop program execution.
Preferences - Opens the Preferences dialog.

Help
Editor Help - Opens this help document in the help viewer.
Galil Suite Help - Opens the help viewer to the GalilSuite main page.
Email Support - Provides a link to send email to Galil's support team. Report bugs or other problems here.
Provide Feedback - An alternative method to send a message to Galil that doesn't require an email client.
www.galilmc.com - Opens Galil's webpage.
About - Displays version information for GalilSuite.

Toolbar

Icon Name Description

New DMC File Creates a new DMC file (.dmc) as a tab in the Program Edit window.

New Project Creates a new project file (.mcp) that is accessed in the Project Explorer.

Open DMC
File

Opens an existing DMC file in a new tab in the Program Edit window.

Open Project Opens an existing project file in the Project Explorer.

Save Saves changes to your current DMC program. This is greyed out if the file currently has no unsaved changes.

Close All Closes all open program tabs. A prompt will be displayed allowing the user to save any changes if needed.

Print Prints the currently open program tab. This prints just the text information in the file.

Undo Allows you to reverse a previous action in the Program Edit window (CTRL+Z)

Redo Allows you to re-do a previous action that had been removed due to using the 'Undo' function.

Cut Removes the highlighted text and puts it in the clipboard where it can be re added to the Program Edit
window using the Paste function. (CTRL+X)

Copy Copies the highlighted text to the clipboard where it can be re added to the Program Edit window using the
Paste function. (CTRL+C)

Paste Takes the last text to be cut/copied and places it in the Program Edit window at the current cursor location.
(CTRL+V)

Select All Selects all text in the currently open DMC file in the Program Edit window. (CTRL+A)

Find and
Replace

Displays the Find and Replace utility to search the Program window for text and replace it with different
text.(CNTL+F)

Download
Project

Downloads the currently active project to the controller. The Project Property window sets the download
behavior.
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Download
Program Downloads the currently open DMC program to the controller.

Upload
Program

Uploads the program currently loaded in the DMC controller and opens it in a new tab in the Program Edit
window.

Download
Array

Sends a .csv file to the controller's array table.

Upload Array Saves the controller's array table to a .csv file.

Execute
Program Sends the "XQ" command to the controller to start program execution.

Stop Program Sends the "ST" command to the controller to stop program execution.

Table 1: Full list of Editor icons and descriptions
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The Viewer Tool
The Viewer is used to obtain a quick snapshot of the controller's important data flags and registers. The data and number of
sections will be dependent on the axis count of the controller.

Figure 1: The Viewer with a DMC-4183 motion controller.

Tool Details

The Viewer is broken into multiple sections which visualize different parts of the controller status. The display will vary based on
the hardware configuration.

Axis Data

The Axis Data portion of the Viewer shows the pertinent data for each axis.

Figure 2: The Axis Data section contains numerical data for each axis present in the controller.

Axis Status

The Axis Status portion of the viewer has virtual LEDs for different flags in the Data Record. See Chapter 4 in your user manual for
a detailed description of each field.
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Figure 3: The Axis Status section contains boolean indicators for each axis present in the controller.

Amp Status

The Amp Status portion of the Viewer will show the current values for each Amp Error bit.

Figure 4: The Viewer Amp Status section contains boolean data for the internal Galil amplifier.

Coordinated Axis

The Coordinated Axis portion of the Viewer gives details pertaining to the coordinated modes of motion - Vector mode (VM) and
Linear Interpolation (LM).

Figure 5: The Coordinated Axis section contains multi axis plane data.

Ethernet Status

The Ethernet Status portion of the Viewer gives details about the type of connection on each available handle. See Chapter 4 in
your user manual for a detailed description of each field.

Ethernet status may not be present on all controllers.

Galil Motion Control The Viewer Tool 20



Figure 6: The Ethernet Status section shows the Ethernet status for each handle of the controller.

General Status/Information

The General Status portion of the Viewer gives details pretaining to general and miscellaneous features of the controller.

This section includes the sample count, error code (TC1; zero indicates no error) and execution LEDs for each thread. The Sample
Count field is the low 16 Bits (65535) of the TIME operand.

  
Figure 7, 8, 9: The General Status/Information for DMC-4183 (left), RIO-47120 (middle), and DMC-30012 (right).

IO Ports

The IO Ports portion of the Viewer gives a quick represention of the Input and Output status on the controller. The LEDs represent
the returned value from @IN[#] and @OUT[#]. @OUT[#] is not supported on all controllers, check the controller command
reference for availability. Some sections, such as extended IO, are not available on all controllers.

Some Controllers will also show the Analog in and Analog out values. These values are going to be in a raw form and will range
from 0 to 65535. Numbers should be interpreted in the context of the controller's AQ and DQ settings if present.

 
Figure 10, 11: The IO Ports section shows the current state of the IO on a DMC-4183 (left) and RIO-47120 (right).

Menus

File
Exit - Closes the Viewer tool.

Viewer
Preferences - Opens the Preferences dialog.

Help
Viewer Help - Opens this help document in the help viewer.
Galil Suite Help - Opens the help viewer to the GalilSuite main page.
Email Support - Provides a link to send email to Galil's support team. Report bugs or other problems here.
Provide Feedback - An alternative method to send a message to Galil that doesn't require an email client.
www.galilmc.com - Opens Galil's webpage.
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Enter License... - Enter the License number for full GalilSuite access.
About - Displays version information for GalilSuite.
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The Scope Tool
The Scope tool allows real-time plotting of all of the items available in the controller data record. There are options for plotting
motor position, reference position, position error, I/O status along with other items such as axis and thread status. The Scope
provides multiple triggering modes such as Auto, Repeat and Single shot.

The Scope cannot be used with an RS-232/USB connection.

Figure 1: The Scope tool showing four data sources plotting in real time. The pink trace shows the derivative of the reference position.

Tool Details

Adding Sources with the Data Source Tool

Each stream of datum plotted on the scope is called a source. In order to graph data on the scope screen, the user must first
choose the sources of interest from the Data Source Tool. Open the Data Sources tool by clicking its icon in the Launcher.
Individual items from the "Data Record" tree, but not from the "Variables" or "Array" trees, may be dragged and dropped onto
the scope window.

Once at least one source is dragged from the Data Source Tool, the Scope is ready to graph. Uncheck the "Trigger" checkbox, click
the Start button followed by the "Auto Scale" toolbar button to graph data on the screen.

Start and Stop

The Start button starts the scope, Stop will halt the scope. When triggering (see below), Start will need to be pressed for each
capture of Single mode, and Stop should be pressed to halt Repeat mode or non-Triggered (sometimes called Auto) mode.

Time Scale (ms)

The Time scale sets the duration of the Scope's data capture. The Scope will sample and graph data for an interval equal to "Total
Time."

Sources

Sources added to the scope can be interacted with in a number of ways.
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Figure 2: A source showing the right-click context menu displayed.

Display Checkbox

Each source has a checkbox to its left which indicates if the source data should be plotted. Uncheck to "turn off" the source
without deleting it.

Div and Offset

The graph area is split up into 20 vertical and 20 horizontal divisions. Each division is marked on a grid and every fifth division is
marked with a bold line. The horizontal axis is always time, and the vertical axis units are defined by the source itself (e.g. Encoder
Counts for _TPA).

The "Div" setting indicates how many units of the source are plotted between consecutive divisions. This defines the vertical scale
of the source.

The center horizontal line indicates the scope absolute origin. The "Offset" value of a source indicates the number of units that the
source waveform is shifted up or down from this absolute origin. When a source has a value of zero and an offset of zero it will
draw as a horizontal line at the center of the scope. Decrementing Offset will move the line down, while incrementing will move
the line up. Note there is a per-channel zero indicator that shows the zero of the source which moves as Offset is changed.
Another way to define the Offset is the distance between the scope's absolute origin (center) and the source's zero.

Change Color

Displays a color chooser to change the waveform color.

Plot d/dt

Plots the three-point discrete derivative of the waveform data. Useful for graphing command velocity from commanded position
_RPm.

Delete

Removes the waveform from the "Plot Data" group box. Drag back from the Data Source Tool to add again. Consider unchecking
the source's display checkbox for temporary removal.

Choosing the "Active Source"

Many features of the scope require that a source be chosen for the operation. This is done by choosing an "Active Source." In the
Plot Data group box, all sources are displayed which have been added from the Data Source Tool. In order to activate a given
source, click the colored source name once. The source control border will appear embossed and depressed when the source is
active.
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Figure 3: The source "_RPA" is active on this scope. "_SCA" is inactive. Operations such as "Trace Data Source" which require an active source will operate on "_RPA."

Mouse Interaction

Dragging Offset

When a source is active, left-clicking in the graph space and dragging vertically will change the waveform vertical position and
update the Offset field of the source.

Scroll wheel zooming

Rolling the mouse scroll wheel will zoom the active source vertically. The zoom target is the cursor location. Div and Offset will be
updated as the zoom occurs.

Zoom Box

In the stop mode, hold the "Ctrl" keyboard key and left click in the graph space. Drag a rectangle and release the mouse button to
zoom in on the box. Right click to go back to the original zoom. Divs, Offsets and the Time Scale will update accordingly.

Triggering

The Scope tool provides a triggering feature which allows the user to define conditions for when a graph should be drawn. This
allows particular states to be automatically drawn upon occurrence. An example of a useful trigger condition in motion control is
to graph position error when the motor passes through a particular point. In this case a trigger could be put on the reference
position (_RPm) at the position of interest.

Figure 4: The Triggering tool has several options

The Trigger check box turns trigger mode on (checked) and off (unchecked)
The Mode combo box selects the type of triggering

None - Don't trigger, similar to unchecking the Trigger check box.
Repeat - On Start wait for the trigger condition, then draw on occurrence. Re-arm and wait for the next occurrence. If
the next occurrence does not come within several seconds, start drawing. Further occurrences of the trigger will pause
on the trigger condition for several seconds.
Single - On Start wait for the trigger condition, then draw on occurrence. Scope then changes to Stop mode.

Source - Indicates which data source is being monitored by the trigger mode. Does not have to be the active source.
Edge - Indicates if the trigger condition occurs when the trigger value is reached from a lower value (rising) or from a greater
value (falling).
Level - Sets the trigger value. When the source passes through this value, a trigger condition has occurred
Display Offset - Sets the relative time position of the trigger within the graph window.

Advanced Options
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The data transmitted by the controller is in binary and from time to time it may be convenient to interpret the binary data in
various ways. The Advanced Options section allows the user to set the type casting (signed and unsigned) as well as number
interpretation. When plotted as "Raw Data", the number is plotted as is. When "Custom Value" is chosen, the number can be
scaled by the value in "Multiplier" and shifted vertically with the "Offset" value. For example, an analog input used with a
thermocouple can easily be scaled to degrees C by choosing the appropriate slope (Multiplier) and DC offset (Offset) for the part.

Menus

File
Exit - Closes the Scope tool.

Scope
Preferences - Opens the Preferences dialog.

Help
Scope Help - Opens this help document in the help viewer.
Galil Suite Help - Opens the help viewer to the GalilSuite main page.
Email Support - Provides a link to send email to Galil's support team. Report bugs or other problems here.
Provide Feedback - An alternative method to send a message to Galil that doesn't require an email client.
www.galilmc.com - Opens Galil's webpage.
Enter License... - Allows user to enter a product license key. Disabled if valid license present.
About - Displays version information for GalilSuite.

Toolbar

Icon Name Description

Print Print the plot area.

Auto
Scale

Splits the graph space equally and vertically among all sources. Automatically chooses the Div and Offset settings
such that each source is contained within its share of the vertical space.

Show
Cursors

Turns on two vertical and two horizontal cursors which can be used for measuring data. Cursors must be enabled
to see the trigger indicator, and to use "Trace Data Source." Click and drag cursors to move.

Show
Points

Displays the actual data points from the controller used to draw the waveform. Use this feature at lower "Total
Time" intervals to determine if a waveform is subject to sampling problems.

Trace
Data
Source

When cursors are enabled, "Trace Data Source" will follow the mouse cursor over the active source and display
the period and frequency from the stationary vertical cursor, and the actual source value and delta from the
stationary horizontal cursor. The trace tool will snap to the actual data points, as shown with the "Show Points"
button. Left clicking on one point and then another will snap cursors to these points for easy measuring. The scope
must be in the "Stop" mode to use this feature.

Advanced
Options

Allows the user to change the interpretation of the source data with respect to type casting, multiplier, and offset.

Table 1: Descriptions of icons available in toolbar.

Example

1. Use the Editor Tool to download and execute a simple program that commands motion to the A axis:

#main
ST
AM
DP 0
SP 25000
AC 256000
DC 256000
#a
PR 2000
BG A
AM A
WT 250
PA 0
BG A
AM A
WT 250
JP#a 

2. Using the Data Source Tool, expand Axis Information|Axis A then hold the CTRL key and click on:
Reference Position
Motor Position
Position Error
Torque

3. Drag these sources onto the Plot Area. Note the sources are shown on the bottom of the screen in the Plot Data.
4. Click the "Start" Button, then click the "Auto Scale" button on the Toolbar.
5. Check the Trigger checkbox. Choose "Repeat" mode, "_RPA" as the source, "Rising" as the Edge, "1.00" as the Level, and

"100.00" as the Display Offset.
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6. Click _TEA in the Plot Data to activate source _TEA
7. Drag the horizontal cursors (dotted lines in Plot Area) to the top and bottom of the _TEA graph. The data on the left side of the

cursors will show the value of that cursor. The top cursor will also show the difference between the two cursors. In this case
the difference is the peak to peak position error.

Figure 5: The Scope should now look something like this. Error (_TEA) and Torque (_TTA) will differ by system.

8. Click and drag up and down in the Plot Area. The _TEA plot will move up and down accordingly.
9. Mouse Wheel in and out over a point on the _TEA plot, the _TEA plot will be zoomed in and out with respect to the mouse

pointer
10. Click _TTA in the Source List and repeat steps 8 and 9 with the _TTA plot.
11. In the Toolbar click the "Advanced Options" button. In the bottom right corner change the drop down of "Raw Data" to -10V

to 10V. Click "Auto Scale" in the toolbar. The _TTA source now graphs Volts/Div
12. Click Stop
13. In the Toolbar click "Trace Data Point", and move the cursors in the plot area to a location on the _TTA source and left-click

the mouse. Note the values at various points
14. Move to another location on the _TTA source and left click the mouse. This places the cursors at those to locations and will

show the values at those two locations as well as the delta time and magnitude.
15. Hold Ctrl and left click to drag a rectangle around a scope area. Release the left click and the scope will zoom into this box

selection. Right click to zoom back out.
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The Watch Tool
Watch is a tool that can be used to view the variables, arrays and data record of a single controller or a collection of controllers in
a single tab.

Figure 1: Watch showing data from both a RIO-47100 and DMC-4020 simultaneously in one tab.

Tool Details

Watch has a unique tab for each connection and within each tab Watch is divided into three columns. The left most column
displays data that was selected from the data record. The middle column displays selected variables and their associated values.
The right most column displays arrays and the values of array elements. Watch can only be used to view arrays and variables on
controllers connected with an RS-232 or USB connection.

Adding Sources

The data to be displayed in Watch is dragged from Data Source, then dropped on the relevant column. Alternatively, an entire
sublist of sources can be added by dragging and dropping the sublist title (text next to the expand triangle). For example, the
entire Data Record for a particular controller could be added to Watch by dragging the Data Record sublist from the Data Source
and dropping it on the Data Record column of Watch. Sources from multiple connections can be displayed in a single Watch tab.

Removing Sources

To remove a source from Watch, right-click on the source and select Delete from the right-click menu. This is demonstrated in the
image below. To remove a controller's entire data set from a column of Watch, right-click on the controller title in the column and
select Delete from the right-click menu. Entire arrays can be removed from Watch in a similar manner. Shift-click or ctrl-click can
be used to select multiple sources before executing a delete.

Figure 2: Removing a source from Watch via the right click menu.
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Connection Tabs

In Watch each connection has its own unique tab. In the first image of Watch, two tabs are seen; "DMC4020, 192.168.1.20, 4635"
and "RIO47100, 192.168.1.122, 1308". The tab title includes the controller type, IP address and connection port. The red X icon
next to the tab title can be used to close a connection tab. A connection tab can be restored from the main toolbar by clicking on
the Watch icon again. As shown in the image below, single tabs can be removed from Watch by clicking and dragging the tab title.
To place a tab back in Watch, the "Dock to Window" icon is clicked.

Figure 3: A single Watch tab showing data from both a RIO-47100 and DMC-4020.

Menus

File
Exit - Closes the Terminal tool.

Watch
Preferences - Opens the Preferences dialog.

Help
Watch Help - Opens this help document in the help viewer.
Galil Suite Help - Opens the help viewer to the GalilSuite main page.
Email Support - Provides a link to send email to Galil's support team. Report bugs or other problems here.
Provide Feedback - An alternative method to send a message to Galil that doesn't require an email client.
www.galilmc.com - Opens Galil's webpage.
Enter License- Opens License Key entry dialog box.
About - Displays version information for GalilSuite.
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The Tuner Tool
The Tuner Tool is a GalilSuite tool which allows the user to quickly and easily tune the PID filters of a servo control system.

Figure 1: Autocrossover Tuning with DMC-31012 controller and drive.

Tool Details

Tuning the PID filter is an essential part of getting stable and accurate performance out of the servo motor system. The Tuner Tool
has several different features, which are used either separately or in conjunction with each other to help determine which values
of KP, KI, KD and other parameters should be used. The tuning methods available are an Autocrossover Tuner, Crossover Tuner ,
General Tuner, Curve Follower Tuner and a Manual Tuner. In addition, the Tuner tool provides a scope to display the results of the
tuning tests, allowing the user to easily evaluate if the performance is sufficient for the application.

Tuner Home

The Tuner Tool opens to a Tuner Home page, which gives a brief explanation of each tuner test available. The Tuner Home page
will look as follows upon opening the first time:

Figure 2: Tuner Home page showing Crossover Tuning summary

By clicking on the radio buttons next to each Tuner method, a brief description of each test is displayed on the right hand side of
the screen. This description summarizes the tuning test, and explains how it works and why a particular method should be used.
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When the desired method to be used for tuning the application is found, simply click on "Select" to move to that tuning method.

Tuning Methods

There are four tuning methods available in the GalilSuite Tuner tool; Autocrossover/Crossover, General, Curve Follower and
Manual.

Crossover/Autocrossover Tuner
The Galil Crossover Tuning attempts to determine the best PID filter parameters based on the crossover frequency of
the particular axis.

General Tuner
The General Tuning tunes the system by repeating a target move and iterating through PID parameters based on the
user input Max/Min/Increment PID settings.

Curve Follower Tuner
The Curve Following Tuning routine is a general, iteration-based method for determining optimum PID filter
parameters based on a sinusoidal motion profile.

Manual Tuner
The Manual Tuning method allows a user to manually enter PID filter values into the tuner, and plot the corresponding
response of the motion profile.

Scope

Upon completing a tuning test, if a Test Profile has been selected the software will run the particular test profile, and graph data
from that profile to screen. This gives the user the ability to look at the results of the tuning and determine if they are acceptable
for the system. If not acceptable, the tests may be re-run with different parameters or setup options. 

The Tuner scope displays four important pieces of information for tuning a motor: commanded motor position, actual motor
position (encoder), position error and torque. Each of these can be used to determine how well a system has been tuned. Upon
completion of the tuning test, the data from that tuning test is auto-scaled and displayed on the four channel scope. In order to
evaluate the data, the Tuner scope allows the user to interact with the data in a variety of ways. The image below shows a
capture of some motion data displayed on the Tuner scope.

Figure 3: Scope Interaction Options

The user may interact with the scope data using the following functions:

Toolbar Display Options - The toolbar has different options available for scope interaction, descriptions for these can be found
in the toolbar section.
Trace On/Off Button - Clicking this button will show or hide the corresponding trace.
Active Trace Button - Clicking on this button determines which source is active. When active, the following scope functions are
available:

Vertical panning: Left mouse clicking on the scope allows dragging the source vertically up or down.
Vertical scaling: Rotating the mouse wheel will increase or decrease the value per division (vertical scaling). This can
also be adjusted via the "Div" box within the Active Trace button.

Zoom Box - Using Ctrl + left mouse allows a zoom box to be drawn over any portion of the scope. Right click to zoom out full.
Cursors - Two vertical and two horizontal cursors are available to help measure data.

Vertical cursors: Upon opening the scope, these are found on the left/right of the scope, and can be moved by left
clicking and moving on the cursor. Data displayed on this cursor is time in msec. The display on the right cursor shows
the time of the right cursor, the delta between the left-right cursor and the corresponding frequency.
Horizontal cursors: These cursors are found initially on the top/bottom of the scope, and also can be moved by left
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clicking and moving on the cursor. The initial top cursor displays the value of the selected data source, as well as the
difference between this value and the second cursor. The initial bottom cursor displays the current value of the selected
data source.

Profile Settings

Multiple test profiles are available to the user for evaluating the performance of a particular set of PID filter values. These profiles
are run after a tuning test is performed (or immediately upon clicking "Tune" in Manual tuning), and move the motor through the
selected profile. The profiles are selected through the "Test Profile" drop down available in each tuning test. The profiles
themselves may be customized for a particular application by selecting the "Profile Settings" button found on the upper toolbar of
each tuning method. Upon opening the Profile Settings guide, the user is presented with the following screen:

Figure 4: Crossover Tuner with Profile Settings shown

The following options may be adjusted within the Profile Settings guide. The type of profile that is executed and plotted after the
tuning has completed is chosen via the "Test Profile" pulldown.
Note: It is important for the user to create a move that will be completed in the time specified in the Record Time Settings.

Profiled Move Settings - This moves the motor forward and reverse based on a standard Galil PR (position relative) move. All
speed, acceleration and deceleration parameters may be adjusted, as well as the delay time between the forward and reverse
move. This move is ideal when the performance of an actual, system appropriate move is desired.

Distance (cts): The distance in counts for the profiled move (eg PRA = "Distance")
Speed: The speed setting for the profiled move. Value is set directly with the SP command.
Accel: The acceleration setting for the profiled move. Value is set directly with the AC command.
Decel: The deceleration setting for the profiled move. Value is set directly with the DC command.
Dwell Time (ms): The dwell time before the controller commands the profiled move in the opposite direction.

Sine Input Settings - This moves the motor in a sinusoidal motion. Amplitude, frequency of oscillation and number of cycles
may be adjusted within this portion. This move is ideal for the curve follower test, as well as for monitoring how well the filter
tracks position.

Amplitude (cts): Amplitude in counts of the profiled sine wave.
Frequency (Hz): Frequency in Hertz of the profiled sine wave.
Cycles: Number of cycles output for the profiled sine wave. - Record Time may need to be increased as number of cycles
increases.

Step Input Setting - The step move is an instantaneous step of the motor forward and reverse. This move does not have any
speed, acceleration or deceleration; it is an instantaneous move of the user selectable amount, with a delay between the
forward and reverse step. This test is ideal for monitoring the motor for absolute stability, as well as for evaluating the end
point settling time and positional tolerance.

Amplitude (cts): Amplitude in counts of the commanded instantaneous step.
Time (ms): Time in ms between the forward step move and the reverse step move.

XQ settings - If a user would rather use their own custom move profile, a program may be written and saved in DMC code.
Current File: If no file is chosen, the program currently residing on the controller will be executed. If a file is chosen with
the browse button, then that specific file will be downloaded to the controller and executed. Once the data is captured
the original file residing on the controller will be replaced.
Label to Execute: If a label is chosen here then the software will execute that label (XQ#label), otherwise the software
will send a general XQ which will start execution at line 0.

Record Time Settings - By default the scope will store 200msec of data, each taken at a rate of RC1 (Refer to the RC command
in the Command Reference for details on this command).

Time (ms): The total recording time in ms.
RC Rate: The recording rate - value set directly with RC command.
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Menus

File
Exit: Closes the Tuner tool and saves configuration settings.

Tuner
Tuner Home: Navigation to Tuner Home
Crossover: Navigation to Crossover Tuner
General: Navigation to General Tuner
Curve Follower: Navigation to Curve Follower Tuner
Manual: Navigation to Manaul Tuner
Preferences: Opens the GalilSuite Preferences dialog

Help
Tuner Help: Opens this help document in the help viewer.
Galil Suite Help: Opens the help viewer to the GalilSuite main page.
Email Support: Provides a link to send email to Galil's support team. Report bugs or other problems here.
Provide Feedback: An alternative method to send a message to Galil that doesn't require an email client.
www.galilmc.com: Opens Galil's webpage.
Enter License: Enter License for full access to GalilSuite Tuner and Scope
About: Displays version and copyright information for GalilSuite.

Toolbar

Icon Name Description

Print Print the plot area.

Auto Scale Set vertical scale (Div) and offset so that all four sources are shown in the scope plot area.

Show Points Displays each data point for the sources on the scope.

Trace Data
Source

Allows for the active data source to be traced with the cursors. Left-click to place first cursor, then left-click
again to place second cursor - mode will then disable.

Profile
Settings

Opens the options for configuring the move that is shown after the tuning function has completed.

Advanced
Settings

Only valid for Manual Tuning - Opens the options for configuring the advanced settings on the controller.

Capture
Overlay

Save the current waveforms as an overlay.

Show
Overlay

Display the overlay waveforms in memory.

Save
Overlay
data

Save out the overlay memory to file (CSV format).

Save Plot
Data

Save out the current waveforms to file (CSV format).

Load Data Load a data file (CSV format) into overlay.

Table 1: Descriptions of icons in toolbar.
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Crossover Tuning
Crossover frequency, which is measured in units of Hz, is defined as the maximum frequency to which a system can respond
without a loss of gain. The Galil crossover tuning tests attempt to determine the best PID filter parameters based on the crossover
frequency of the particular axis.

Figure 1: Autocrossover Tuning with DMC-31012 controller and drive.

Crossover Tuner Details

There are two methods of using crossover frequency to tune an axis.

Crossover Frequency
This routine allows the user to define a crossover frequency (Hz), and then attempts to tune the axis to provide the best
system response at that frequency. A slider bar allows the user to fine tune the system for either slower or faster
response. Slower response will be more sluggish, but more stable. Faster response will be faster responding, but tend to
overshoot more.
The Crossover Tuning is ideal when a user wants to tune a system based on bandwidth/crossover frequency and has a
rough idea of the bandwidth or responsiveness of their system, but no knowledge of PID gains. A crossover value lower
than their system bandwidth is used as a starting point, and then slowly increased up to the desired performance.

Autocrossover Frequency
This routine searches through a wide range of crossover frequencies, and attempts to find the PID parameters which
correspond to the calculated crossover frequency.
The Autocrossover Tuning is ideal when a user does not know either system bandwidth or rough PID values. If a user
does have a rough idea of their PID values, either the General or Curve Follower tuning routines are recommended.

Crossover Tuner - Usage

The following options may be selected to customize the tuning test to a particular application:

Axis - Drop box for choosing the axis for tuning.
Pulse Magnitude - Both the Autocrossover and Crossover subject the axes to a series of pulse inputs to determine the best PID
filter values. If the default of 5V is not appropriate for a system, the value may be lowered or raised. Examples of the default
not working are if the system requires a lower torque limit, or if the load is too large for the pulse to properly move the motor.
Pulse Duration - This duration describes the time over which the Pulse is applied. Longer durations may be required for
systems with higher friction or inertia.
Test Profile - After the tuning test has completed and found the best PID filter values, a test profile is run to graphically display
the performance of the new values. This tuning profile may be selected by the Test Profile drop down. Profiles may be adjusted
via the Profile Setting selection on the upper toolbar.

Autocrossover checkbox - This check box should be selected to use Autocrossover (checked) vs. Crossover (unchecked) tuning
test.
System Response (Hz) - Only valid when Autocrossover is not checked. This slider bar can be adjusted to give the system a
faster or slower response. Default value of 30Hz is a good place to begin testing.

Filter Values - Shows the current PID settings for the Axis. These will update as tuning functions are being performed.

Tune - This button starts the tuning process for the specified axis.
Abort - This button aborts the tuning process for the specified axis, the axis will be left in a motor off state.
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Restore Defaults - This button restores the default settings for the tuning setup and the Profile Settings.
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Curve Follower Tuning
The Curve Following Tuning method is a general, iteration-based method for determining optimum PID filter parameters based on
a sinusoidal motion profile. A user defines the frequency and amplitude of the sinusoidal motion profile over which the tuning will
occur. The Curve Follower tuner then tunes the system by repeating this sinusoidal profile and iterating through PID parameters
based on the user input Max/Min/Increment PID settings. The Curve Follower tuner monitors position error over the entire
sinusoidal motion of the motor, and determines the PID values which give the lowest following error while maintaining motor
stability. Upon test completion, ideal PID parameters are determined with the corresponding minimum positional error.

Figure 1: Curve Follower Tuning with DMC-31012 controller and drive.

Curve Follower Tuner Details

The Curve Follower Tuning is an ideal tuning method to use when minimum position error is required over a full profile, rather than
minimum settling time at an end point. This tuning method attempts to select PID parameters which will give the lowest position
error over the course of the entire motion profile. This is beneficial for path following applications such as XY dispense applications,
laser cutting or scanning applications, or similar. This method has the benefit of tuning within a user selectable distance
(amplitude), so works well on systems with limited motion travel. If high-speed point-to-point motion is required, either the Auto-
crossover or General tuning methods are recommended.

Curve Follower Tuner - Usage

The following options may be selected to customize the tuning test to a particular application:

Axis - Drop box for choosing the axis for tuning.
Magnitude - Magnitude in counts of the sinusoidal profile which will be used for the tuning routine.
Frequency - Frequency in Hz of the sinusoidal profile which will be used for the tuning routine.
Test Profile - After the tuning test has completed and found the best PID filter values, a test profile is run to graphically display
the performance of the new values. This tuning profile may be selected by the Test Profile drop down. Profiles may be adjusted
via the Profile Setting selection on the upper toolbar.

Filter Ranges
KP/KI/KD MIN: Minimum search values for the KP, KI and KD filter terms.
KP/KI/KD MAX: Maximum search values for the KP, KI and KD filter terms.
KP/KI/KD INC: Amount to increment KP, KI and KD per iteration of the tuning routine.

Tune - This button starts the tuning process for the specified axis.
Abort - This button aborts the tuning process for the specified axis, the axis will be left in a motor off state.
Restore Defaults - This button restores the default settings for the tuning setup and the Profile Settings.
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General Tuning
The General Tuning routine is a simple, iteration-based method for determining optimum PID filter parameters based on a point-
to-point move profile. A user defines a target move profile over which the tuning will occur. The General Tuning tunes the system
by repeating this target move and iterating through PID parameters based on the user input Max/Min/Increment PID settings. At
each increment, the motion is monitored for instability. PID gains continue increasing until instability occurs, and then are backed
down. 

In this test, the tuner finds the best KP for a given value of KD. Once the best KP is found, KD is increased and the tuner finds the
best KP again. This process is repeated until KD cannot be increased further without causing instability in the system. The tuning
routine then decreases KP and KD to stable values. At the last step, the highest stable value for KI is determined and added to the
system.

Figure 1: General Tuning with DMC-31012 controller and drive.

General Tuner Details

The General Tuning method is an ideal tuning method to use when the user has a rough idea of their PID values which can be
bounded by the MIN and MAX ranges. In addition, this test has the benefit of tuning within a user selectable distance, so is ideal
for applications with constrained motion. Finally, this test measures stability at the end point, so works well for point-to-point
motion applications. PID values determined with this method tend to be less aggressive than those determined by the Auto-
crossover method.

General Tuner - Usage

The following options may be selected to customize the tuning test to a particular application:

Axis - Drop box for choosing the axis for tuning.
Tuning Distance - Incremental distance of target move which will be used for the tuning routine.
Speed (cts/sec) - Commanded speed of target move which will be used for the tuning routine.
AC/DC (cts/sec^2) - Commanded acceleration and deceleration of target move which will be used for the tuning routine.
Test Profile - After the tuning test has completed and found the best PID filter values, a test profile is run to graphically display
the performance of the new values. This tuning profile may be selected by the Test Profile drop down. Profiles may be adjusted
via the Profile Setting selection on the upper toolbar.

Filter Ranges
KP/KI/KD MIN: Minimum search values for the KP, KI and KD filter terms.
KP/KI/KD MAX: Maximum search values for the KP, KI and KD filter terms.
KP/KI/KD INC: Amount to increment KP, KI and KD per iteration of the tuning routine.

Tune - This button starts the tuning process for the specified axis.
Abort - This button aborts the tuning process for the specified axis, the axis will be left in a motor off state.
Restore Defaults - This button restores the default settings for the tuning setup and the Profile Settings.
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Manual Tuning
The Manual Tuning method allows a user to manually enter PID filter values into the tuner, and plot the corresponding response of
the motion profile. This method allows for PID values to be adjusted manually via text entry or slider bar, and additionally allows
advanced users to adjust some of the higher level Galil filter parameters (ie. Pole filter, Notch filter, Feedforward terms). These
parameters are then applied, and the user selectable motion profile is graphed in the tuner scope.

Figure 1: Manual Tuning with DMC-31012 controller and drive.

Manual Tuner Details

The Manual Tuning method is ideal for a few tuning purposes. First, it is helpful for advanced users who want a convenient user
interface for tuning their motors, and know what kind of motion response they are looking for. Second, it is helpful for customers
who have determined their rough PID parameters via other tuning methods (Auto-crossover, Curve, etc), but want to fine tune
further. And lastly, it is helpful for customers with existing systems who may want to view and modify their existing PID gains.

Manual Tuner - Usage

The Manual tuning test doesn't have any automatic tuning functions. Rather it gives the user the ability to change any controller
setting and then graphically display those changes. The following options may be selected and/or adjusted for the Manual tuning
test:

Axis - Drop box for choosing the axis for tuning.
Test Profile - A test profile is run to graphically display the performance of the new values. This tuning profile may be selected
by the Test Profile drop down. Profiles may be adjusted via the Profile Setting selection on the upper toolbar.
Loop Test Profile - When tuning a motor manually, it is often helpful to have the Test profile constantly looping. In this way the
user doesn't need to continually select “Tune” to re-run the profile; it is run constantly at a fixed rate. To stop the looping
profile, simply de-select the “Loop Test Profile” option.

Filter Values - KD/KP/KI slider bars - The main KP, KI and KD parameters may be adjusted either by slider bar, or by entering
values directly into the text box field.

Advanced Settings - The icon displaying the Toolbox on the upper toolbar will open the Advanced filter parameters display. In
this display, all of the higher level filter features may be adjusted. In addition, if a user has Galil ceramic firmware, all of the
ceramic motor specific filter parameters may be adjusted.

General:
Sample Time (TM): The update rate of the controller. See the TM command for more information
Integrator Limit(IL): The limit for the contribution of the integrator. See the IL command for more information.
Torque Limit (TL): The limit on the motor command output. See the TL command for more information.
Peak Torque (TK): The peak limit on the motor command output. See the TK command for more information.

Advanced Filters:
Notch Freq (NF): Sets the frequency of the notch filter. See the NF command for more information.
Notch B/W (NB): Sets the real part of the notch poles. See the NB command for more information.
Notch Depth (NZ): Sets the real part of the notch zeros. See the NZ command for more information.
Pole/Low Pass (PL): Adds a low-pass filter in series with the PID compensation. See the PL command for more
information.
Profile Smoothing (IT): Filters the acceleration and deceleration functions of independent moves. See the IT
command for more information.
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Feed Forward:
FF Acceleration (FA): Sets the acceleration feedforward coefficient. See the FA command for more information.
FF Velocity (FV): Sets the velocity feedfoward coefficient. See the FV command for more information.

Ceramic Tuning: Settings for tuning ceramic motors. Requires ceramic firmware.
Anti Friction Positive (ZP): Adds a positive open loop voltage to the controller's command signal when the
position error is positive. See the ZP command for more information.
Anti Friction Negative (ZN): Adds a negative open loop voltage to the controller's command signal when the
position error is negative. See the ZN command for more information.
Deadband Active (DS): Range in which PID and antifriction bias are turned off (off band). See the DS command
for more information.
Deadband Inactive (DB): Range in which PID and antifriction bias are turned on (on band). See the DB command
for more information.
Deadband Error (CP): Dead band within which the motor is shut off (MO). See the CP command for more
information.
Deadband Integrator (CT): Specifies the rate at which the integrator limit IL is incremented. Not available on all
controllers.
Ceramic Feedforward (FC): Distance-selectable feedforward gain. See the FC command for more information.
Feedforward Dist (FN): Distance from end of move when FC is engaged. See the FN command for more
information.
KP Motion (K1): The proportional gain in effect when the profiler is commanding motion (RP is changing). See the
K1 command for more information.
KD Motion (K3): The derivative gain in effect when the profiler is commanding motion (RP is changing). See the
K3 command for more information.
KI Motion (K2): The integral gain in effect when the profiler is commanding motion (RP is changing). See the K2
command for more information.

Tune - This button starts the tuning process for the specified axis.
Abort - This button aborts the tuning process for the specified axis, the axis will be left in a motor off state.
Restore Defaults - This button restores the default settings for the tuning setup and the Profile Settings.
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The Configuration Tool
The configuration tool is used to modify controller settings, backup & restore parameters, and download firmware.

Figure 1: The Configuration tool showing an active connection tab, the System Identification header, System Settings,and the Command Output window.

Tool Details

The Configuration tool is broken into 4 sections. The top section is for System Identification.  This shows the controller model
number, firmware version, controller serial number, and (if available) the internal board IDs such as servo or stepper amplifiers.

The second section has Special settings that include the type of display format such as how many integers to display and whether
leading zeros should be displayed or not.

The third section displays all of the internal parameters for all available axes.  These can be edited directly from the configuration
screen and any value that is entered will be directly sent to the controller.  To burn the parameters to the controllers non-volatile
memory, goto "Configuration" menu item, then click "Burn EEPROM" and "Burn Parameters".

The optional bottom section is called "Command Output" and will give you the current status. This will show you whether the
configuration was loaded succesfully as well as show you what error occurs if an incorrect value is issued.  For instance, if a Motor
Type value of 20 is entered for axis A, the following error will show up in the Command Output -> "Motor Type failed:
CMD[MTA=20] Reply[?] due to 6 Number out of range".  This Command Output view can be turned off by going to the View menu
item and unchecking "Output".

Menus

File
Backup to file - provides the capabilty of saving all parameters, arrays, variables, and program to a single .bak file.  This
can be used to perform a complete backup/restore function.
Restore from file - allows a user to restore a controller using a previously saved .bak backup file.  This will restore the
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program, parameters, variables and arrays.
Backup parameters to DMC file - this is a convienent way to output the current set of parameters to a .DMC program
that can be run on the controller.  This does not require the use of Galil Suite to restore a controllers parameters.
Exit - Closes the Configuration tool.

View
Output - Shows or hides the Output window at the bottom of the tool.

Configuration
Refresh Display - this will cause the software to fetch the current parameters from the controller.  This should be used if
parameters are changed from the Terminal window and the changes need to be updated to the Configuration screen.
Burn EEPROM >

Burn All - this sends the BP, BN, and BV commands to burn all items into non-volatile memory.
Burn Program - this sends the BP command to burn just the current program into non-volatile memory.
Burn Parameters - this sends the BN command to burn just the parameters into non-volatile memory.
Burn Variables and Arrays - this sends the BV command to burn just the variables and arrays into non-volatile
memory.

Load Firmware - this allows the user to load new firmware into the controller.  It requires a compatible .hex file be
provided.  For the latest standard firmware, visit the Galil website.
Preferences - this opens the standard Preferences screen that allows the user to configure various preferences about
the tool.

Help
Configuration Help - Opens this help document in the help viewer.
Galil Suite Help - Opens the help viewer to the GalilSuite main page.
Email Support - Provides a mailto feature to send email to Galil's support team. Report bugs or other problems here.
Provide Feedback - An alternative method to send a message to Galil that doesn't require an email client.
www.galilmc.com - Opens Galil's webpage.
About - Displays version information for GalilSuite.

Figure 2: Help for each command can be accessed by first opening the generic Help window and then clicking on the command you need more info on.
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The Data Source Tool
Data Source is used to select data of interest from controllers. The data listed in the Data Source window can be added to Scope
for a graphical presentation or to Watch for a numerical representation. This is accomplished via drag and drop.

Figure 1: Data Source showing some of the available data sources for a RIO-47100 controller.

Tool Details

Data Source has a unique tab for each connection. In each tab a collection of the possible data sources for the particular controller
are displayed. The Data Sources are broken up into sublists which are expandable by clicking on the small triangle next to the
sublist title. It should be noted that entire sublists can be dragged from the Data Source window. Only Data Record entries can be
plotted via Scope. Arrays, variables, and Data Record entries can be displayed via Watch. Accessing the data record is only possible
on Ethernet and PCI based controllers.

Multiple Data Sources

To drag multiple sources from Data Sources in one operation, shift-click or ctrl-click can be used to select multiple sources before
executing a drag and drop operation.

Connection Tabs

In the first image of Data Sources, two tabs are seen; "DMC4020, 192.168.1.20, 4635" and "RIO47100, 192.168.1.122, 1308".
The tab title is the controller type, IP address and connection port. The red X icon next to the tab title can be used to close a
connection tab. A connection tab can be restored from the main toolbar by clicking on the Data Sources icon again. As shown in
the image below, single tabs can be removed from Data Sources by clicking and dragging the tab title. To place a tab back in the
main watch window, the "Dock to Window" icon is clicked. This is the only icon in the tab's toolbar and it looks like two tabs.

Figure 2: A Data Source tab removed from the main Data Source window.
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Menus

File
Exit - Closes the Data Sources tool.

Sources
Preferences - Opens the Preferences dialog.

Help
Source Help - Opens this help document in the help viewer.
Galil Suite Help - Opens the help viewer to the GalilSuite main page.
Email Support - Provides a link to send email to Galil's support team. Report bugs or other problems here.
Provide Feedback - An alternative method to send a message to Galil that doesn't require an email client.
www.galilmc.com - Opens Galil's webpage.
Enter License- Opens License Key entry dialog box.
About - Displays version information for GalilSuite.
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The DMC Helper Utility
The DMC Helper is a side-bar available in both the Terminal and the Editor Tools. DMC Helper allows a user to select a command
from a categorized list and place it in your program or terminal rather than typing the command manually. This is useful for users
to get more familiar with the DMC language and structure. 

Commands are grouped by category in order to find them easily.

Figure 1: DMC Helper side-bar with the "Independent Motion" category selected and corresponding commands listed.

The majority of Galil commands can be placed into two categories, numeric and axis-mask. Numeric commands require the user to
set an integer or decimal number to apply to the command, such as Acceleration "AC" (in counts/second^2). Axis-mask commands
require the user to choose an axis or combination of axes that apply to the command, such as Begin "BG". For any command, the
"Info" tab gives basic syntax information in the DMC Helper.

Numeric Commands

For Numeric commands, there are typically two ways to input the command, Explicit notation or Implicit notation. Explicit
notation is used in the "Single Axis" tab, while implicit notation is used in the "Multi Axis" tab.

Explicit Notation (Single Axis)

When using the "Single Axis" tab, the axis to assign a value to is specified in the command. To set this, select the axis from a drop
down menu. Once selected, enter the value for the command in the "Data" textbox. The greyed out textbox shows a preview of
the command. Once the command is complete, click "Insert" to add it to the Editor or Terminal Tool.

Figure 2: Entering acceleration (AC) for the A-axis using the Single Axis tab.
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Implicit Notation (Multi Axis)

When using the "Multi Axis" tab, no specific axis is designated in the command, and data for different axes is separated by
commas. Enter values into the textbox next to the axis letter that this value will be applied. The greyed out textbox shows a
preview of the command. Once the command is complete, click "Insert" to add it to the Editor or Terminal Tool.

Figure 3: Entering acceleration for the A-, B-, and C-axis using the Multi Axis tab.

Note that the user can also insert only a single-axis' worth of information in the Multi-axis tab, but the syntax (shown in the
greyed-out "preview" box) will be different.

Axis Mask Commands

For axis mask commands such as "BG", the user is prompted with a list of acceptable Axis masks to choose from. Click the
checkboxes for the axis values to be used in the command. The greyed out textbox shows a preview of the command. Once
complete, click "Insert" to add the command to the Editor or Terminal Tool.

Figure 4: DMC Helper Axis Mask tab.

Operands

Many Galil commands can also act as an operand. A command's operand stores a value in a form that is queriable by the user, or
can be used as a parameter in a DMC program. Operands are commonly used in conjunction with the "MG" command to return
the value of the selected operand.

In the Operand tab, users select the axis for the operand. The image below shows an example of this. The operand of AC will
returns the current value of "AC" set for whatever axis is of interest.
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Figure 5: DMC Helper Operands tab.
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Preferences
The Preferences window is used to configure settings and behavior of the various tools of GalilSuite.

Figure 1: The Preferences window where the user can configure GalilSuite

Preferences screen Details

There are eight preference windows.

General

In General preferences, the user can choose to save the current profile on exiting GalilSuite, the state of the code helpers,
compression directives, default paths, the default command set,size of messaging buffers, and abort behavior.

Figure 2: The General preferences options

Save Profile on Exit
Check this box to store current preferences whenever GalilSuite is closed.
Uncheck this box to not store any changes.

Show Auto-Complete
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Check this box to enable the Auto-Complete feature in all applicable tools.
Uncheck this box to disable the Auto-Complete feature in all applicable tools.

Show DMC Helper
Check this box to enable the DMC Helper feature in all applicable tools.
Uncheck this box to disable the DMC Helper feature in all applicable tools.

Compress DMC Code before download
The following compression options will be toggled on or off with this setting. Add a DMC file to a project for fine-grain
control of each of these options.

Remove blank lines - Blank lines will be removed to save space.
Remove leading spaces - Leading spaces will be removed.
Remove comments - Comments (') will be removed.
Remove NO - No-Ops (NO) will be removed.
Compact lines - Code will be concatenated to fill line width.
Use tick - Where supported, the back tick (`) will be used to optimize compression.

Default Folder sets the default path for GalilSuite.
Disconnected Command Set selects the product command subset to use while not connected to hardware.
Message Rate

Buffer size relates to the volume of messages printed in Terminal response window before deleting of old messages
Display Rate sets how much data is to appear every 100 msec

Abort Option sets the abort button behavior
Stop with deceleration - Sends "ST". Motor will decelerate if moving and stay in servo.
Disable motors - Sends "AB;MO". Motor will coast stop.
Stop instantaneously - Sends "AB". Motor will stop without deceleration and stay in servo. If "OE" is set to 1, the axis
will coast stop.

Document Format

The Document Format preferences allow the user to set standard text font, color, and format for documents that do not use the
Syntax Highlighting feature.

Figure 3: The Document Format preferences options

Font and Color
Set font and colors of text displayed in Galilsuite

Tab size
Select how wide a character will indent code. If a tab character is found in a DMC file, this setting indicates the number
of spaces that will be substituted.

Syntax Highlighting

The Syntax Highlighting preferences allow the user to set text color and style for the syntax highlighting feature of GalilSuite.
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Figure 4: The Syntax Highlighting options

Color Group
Select color group to modify. The user can then set text color and style

Launcher Toolbar

The Launcher Toolbar preference allows the user to set the icon size as either Compact or Large.

Terminal

The Terminal preferences allow the user to set automatic repeat and log file settings for the Terminal tool.

Figure 5: The Terminal options

Auto Repeat setting
Set repeat time for automatic command repeater. Turn on and off the repeater within the Terminal window.

Log File setting
Set the maximum possible log file size. Start and stop the Logging capability in the Terminal by choosing File...Log to
File. Create a text file, and upon saving, the logging will commence.

Tuner

The Tuner preferences allow the user to change settings for the Tuner tool.
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Figure 6: The Tuner options

Backup and Restore
Choose to restore original DMC program after the tuning process is complete.

Editor

The Editor preferences allow the user to set Editor tool settings.

Figure 7: The Editor options

Default and Startup
Choose to automatically run the DMC program after program download icon is clicked in Editor.

System Configuration

The System Configuration preferences allow the user to set automatic repeat and log file settings for the Configuration tool.
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Figure 8: The System Configuration options

Display Restore Configuration Options
Choose to Display restore options when the user selects to Restore from File in the System Configuration tool

Restore Parameters
Choose to restore parameters when running Restore tool

Restore Variables and Arrays
Choose to restore variables and arrays when running Restore tool

Restore Program
Choose to restore DMC program when running Restore tool

Advanced Timing

The Advanced Timing preferences allow the user to set advanced timeout settings for special commands issued through the
Terminal tool.

Figure 9: The Advanced Timing options

BX and BZ Timeout
Set the timeout, in msec, for the brushless configuration commands BX and BZ

BN, BV, and BP Timeout
Set the timeout, in msec, for Burn commands BN, BV, and BP
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The Profile Manager
The Profile Manager provides a convenient and simple interface for configuring these user profiles.

Figure 1: The Profile Manager listing the default Profile.

Tool Details

GalilSuite provides the user with the ability to save all of the GUI layout and configuration preferences into distinct user profiles.
This profile contains all pertinent GUI information such as open tools (ie. Terminal, Watch, Tuner, etc), tool position and size within
the desktop, default program files in the Editor, data sources and scaling for the Watch and Scope, and many other items. The
user is able to set up the GalilSuite GUI according to their preferences, and save this as a profile which can be loaded each time
GalilSuite is opened.

The Profile Manager provides a convenient and simple interface for configuring these user profiles. In addition to allowing the user
to save the default or power up profile, it also allows the user to save or create multiple user profiles. In this way, multiple users
accessing the same machine are able to have different GUI preferences, each stored in a distinct profile. The user is also able to
select which profile is the startup profile, and can even have a specific controller connection made on each GalilSuite startup.

Default Profile Operation

By default, GalilSuite will automatically save the GUI layout and configuration each time GalilSuite is closed. Upon each successive
startup, the default profile will be loaded. If the user would prefer to disable this auto save feature, the "Save Profile on Exit" box
may be un-checked in the GalilSuite Preferences. If disabled, user profiles are only saved by manually saving from the Profile
Manager.

Profile Manager Main Interface

The main Profile Manager interface is where the user will create and edit user profiles. The Profile Manager is accessed by the
selecting the Profile Manager icon.

Figure 2: The Profiles Icon on the GalilSuite Dashboard.

This will open the Profile Manager window, which shows all currently available user profiles, as well as allows adding, editing and
saving of profiles.

The "default" profile is always available in the Profile Manager. This is the profile to which all information is saved by default, and is
also the default startup profile.
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Figure 3: The Profile Manager interface, with only the "default" profile saved

Adding a New Profile

A new user profile may be added to the Profile Manager by selecting “New Profile”. This will bring up the New Profile window

Figure 4: The New Profile window

The first step in adding a user profile is to name the new profile by typing a distinct name into the text box. In the example above,
the new profile has been given the name "XYZ Machine". Next, the profile may be designated as the startup profile (ie. Profile
which is loaded each time GalilSuite is opened) by having "Set as startup profile" selected.

The Restore Connections option allows the user to have GalilSuite automatically connect to the selected controller (or multiple
controllers if multiple tabs were saved). When not checked, this option causes GalilSuite to open with no controller connections
made (ie. All connections are "Disconnected"). When checked, this option saves the current connection status of all tabs which are
currently open. As seen in the new profile shown above, the current connection status for a DMC-4040 has been saved. In this
way, upon loading this profile or GalilSuite starting up, the software will automatically attempt to connect to this controller and IP
address.

Editing an Existing Profile

The settings for any currently saved profile may be edited by highlighting the profile in the Profile Manager, and selecting "Edit".
This will bring up the settings for the selected profile.

Figure 5: The Edit Profile window

The profile editor allows the user to change the name of the specified profile, change the start-up status and change any of the
connection related information. Upon Save, the new settings are saved to the profile.

Loading a User Profile

Any profile found in the Profile Manager may be loaded by highlighting the selected profile, and selecting "Load". This will change
the GalilSuite GUI to the settings found in that particular profile, including window/tool status, saved connections and all other
profile information.
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Editing an Existing Profile

The current user profile will be saved automatically each time GalilSuite is closed, unless the preferences for "Save Profile on exit"
have been disabled. Assuming the profile is being saved on exit, saving the profile manually via the Save button is not required.
However, if a user needed to switch to a different profile without closing GalilSuite, the current profile information could be saved
by highlighting the current profile and selecting "Save" in the Profile Manager.

Editing an Existing Profile

Any user profile can easily be deleted by highlighting the desired profile, and selecting "Delete" in the Profile Manager.
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PCI Installer (Windows)
The PCI driver for GalilSuite is a seperate executible file (.exe) from the main installation file. The PCI drivers are availble for
downlaod on our software website, here: Software Downloads. PCI drivers are supported for the following controllers:

DMC-18x0^
DMC-18x2^*
DMC-18x6

* No Scope, Watch, or Viewer support.
^ Only Xilinx versions of these cards are fully supported. Contact Galil if you have a PLX revision of these cards or are unsure how to
check.

Chosing the Right Driver

The current revision PCI drivers are downloaded as a single .zip file. Once open, there are several .exe available to choose from.
The installation file chosen should reflect the operating system you're using GalilSuite on. Use the following table to determine the
installation file appropriate for you.

x86 (32-bit) x64 (64-bit)
Windows XP GalilSuitePCI-xp-x86.exe Not Supported.

Windows 7 GalilSuitePCI-win7-x86.exe GalilSuitePCI-win7-x64.exe

Windows 8 GalilSuitePCI-win8-x86.exe GalilSuitePCI-win8-x64.exe

Linux (Red Hat) See Red Hat Installaton Guide

Linux (Ubuntu) See Ubuntu Installaton Guide

Installation

Once your correct driver is selected, double click the executible to begin installation. Two windows will open up, as shown:

Figure 1: Progress window Figure 2: Installer window

The window in Figure 1 provides a progress bar as the installation process continues. The second window will require action by the
user.

Press "Next" in the window in Figure 2 to continue.

Figure 3: Installing driver, wait until complete Figure 4: Driver completed installaton

Once installation is complete, click "Finish" as shown in Figure 4, the window will close. The progress bar will now show completed
in the second window. Select "Close" as shown in Figure 5.
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Figure 5: Progress bar should show complete.

All installation windows should now be closed. Open up GalilSuite and press the "+" Connect button in the Launcher to open up the
Device List. You should now see your PCI card, ready to connect.

Figure 6: A properly installed driver will allow you to connect to your PCI card.

If your PCI controller cannot be found, try restarting your PC. If you're still having issues, check out the Troubleshooting section
below

Troubleshooting

If you are unable to find your driver it is usually due to the following reasons: (1) If you have had prior generation Galil software
installed on the same computer, the wrong driver may be in use. (2) The driver was unable to install properly. To diagnose the
issue use Windows Device manager.

Although Windows XP, 7, and 8 have very different Control Panels, they all use the same Device Manager interface. The following
example images uses Windows 7, thus some variances are expected on differnet OS systems.

Figure 7: Windows Device Manager

Galil Motion Control PCI Installer 56



Find your Galil or PCI device in the Device Manger. Figure 8 and 9 show how scenario (1) and (2) will present themselves,
respectivly. Figure 10 shows a properly installed driver.

Figure 7: Incorrect driver installed (GalilTools Driver) Figure 8: Driver not recognized or installed. Figure 9: GalilSuite driver properly installed.

Both scenario (1) and (2) are solved in the same manner:

Right click the DMC-18x6 or PCI Device and select "Properties". The following window will open below:

Figure 10: Properties

Go to the "Driver" Tab and Select "Update Driver." You will be prompted by the following menu:

Figure 11: Search For dirver software

Select "Browse my computer for driver software." Windows will prompt again:
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Figure 12: Pick from List

Select "Let me pick from a list of device drivers on my computer." Windows will present the list:

Figure 13: Driver list

Choose "DMC-18x0-GS", "DMC-18x2-GS", or "DMC-18x6-GS" depending on your contoller type, and select "Next"

If the "DMC-18x0-GS", "DMC-18x2-GS", or "DMC-18x6-GS" driver was not available, or could not be found, try uninstalling all
Galil software. Restart you PC and install only GalilSuite and the PCI executible. Be sure you're using the right PCI executible
one for your operating system. See Selecting the Right Driver.
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Figure 14: Driver Installed

If you're still having trouble, contact Galil.
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Installing GalilSuite 1.0.2 on Red Hat 5.8

Install GalilSuite Software Package
This section covers the installation of the GalilSuite 64 bit software package. After installing the GalilSuite software package, additional
configuration may be necessary. Any previous installations of GalilSuite must be removed before installing the latest version.

Before using a PCI controller, the GalilSuite PCI driver must be installed.
Before using a Ethernet based controller, the firewall must be modified.

This document will outline the complete setup of GalilSuite for any or all controller communication interfaces.

1. Open a terminal by clicking Applications>Accessories>Terminal.
2. Get the Galil public key and import it into the package manager.

$ wget http://www.galilmc.com/support/downloads/software/galilsuite/linux/galil_public_key.asc
$ su -c 'rpm --import galil_public_key.asc'
Password:

3. Get the GalilSuite package and install it with the package manager.

$ wget http://www.galilmc.com/support/downloads/software/galilsuite/linux/galilsuite.x86_64.rpm
$ su -c 'rpm -i galilsuite.x86_64.rpm'
Password:

4. GalilSuite can be launched from the terminal with the command "galilsuite" or from the system menu at
Applications>Programming>GalilSuite.

Install the GalilSuite PCI Driver
If GalilSuite is to be used with a PCI based controller, the GalilSuite PCI driver must be installed. If GalilSuite will not be used with a PCI based
controller, this section can be skipped. If the GalilTools PCI driver has been previously installed, it must be removed before installing the
GalilSuite PCI driver. While there is limited support for the GalilTools PCI driver in GalilSuite, it is strongly recommended that the GalilSuite PCI
driver is used with GalilSuite.

1. Open a terminal by clicking Applications>Accessories>Terminal.
2. Download the required packages for the build process.

$ su -c 'yum install rpm-build kernel-devel kernel-headers kernel-xen gcc glib'
Password:

3. Prepare the build environment.

$ mkdir -p ~/rpmbuild/{BUILD,RPMS,SOURCES,SPECS,SRPMS}
$ echo '%_topdir %(echo $HOME)/rpmbuild' > ~/.rpmmacros

4. Download the Linux PCI driver from the Galil website.

$ wget http://www.galilmc.com/support/downloads/software/galilsuite/linux/galilsuite-pci.src.rpm

5. Rebuild the GalilSuite PCI driver using rpmbuild.

$ rpmbuild --rebuild galilsuite-pci.src.rpm

6. Move the newly built package into the working directory.

$ mv ~/rpmbuild/RPMS/x86_64/galilsuite-pci*.x86_64.rpm galilsuite-pci.x86_64.rpm

7. Install the newly build package.

$ su -c 'rpm -i galilsuite-pci.x86_64.rpm'
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Configure the Firewall
1. Open a terminal by clicking Applications>Accessories>Terminal.
2. Assuming that the firewall is enabled, a file similar to the following can be found at "/etc/sysconfig/iptables". Open this file for editing.

$ su -c 'gedit /etc/sysconfig/iptables'
Password:

3. If the file opened by the previous command is blank, you must re-enable the redhat firewall. Modifications to the iptables file may have
been previously made for services like windows file sharing. The unmodified version is given only for demonstration purposes.

$ su -c 'gedit /etc/sysconfig/iptables'
Password:
# Firewall configuration written by system-config-securitylevel
# Manual customization of this file is not recommended.
*filter
:INPUT ACCEPT [0:0]
:FORWARD ACCEPT [0:0]
:OUTPUT ACCEPT [0:0]
:RH-Firewall-1-INPUT - [0:0]
-A INPUT -j RH-Firewall-1-INPUT
-A FORWARD -j RH-Firewall-1-INPUT
-A RH-Firewall-1-INPUT -i lo -j ACCEPT
-A RH-Firewall-1-INPUT -p icmp --icmp-type any -j ACCEPT
-A RH-Firewall-1-INPUT -p 50 -j ACCEPT
-A RH-Firewall-1-INPUT -p 51 -j ACCEPT
-A RH-Firewall-1-INPUT -p udp --dport 5353 -d 224.0.0.251 -j ACCEPT
-A RH-Firewall-1-INPUT -p udp -m udp --dport 631 -j ACCEPT
-A RH-Firewall-1-INPUT -p tcp -m tcp --dport 631 -j ACCEPT
-A RH-Firewall-1-INPUT -m state --state ESTABLISHED,RELATED -j ACCEPT
-A RH-Firewall-1-INPUT -m state --state NEW -m tcp -p tcp --dport 22 -j ACCEPT
-A RH-Firewall-1-INPUT -j REJECT --reject-with icmp-host-prohibited
COMMIT

4. Modify the "/etc/sysconfig/iptables" file to include the lines that are highlighted in the listing below. These lines include exceptions that
allow for the connection to Galil controllers over Ethernet and the ability to find and assign IP addresses to Ethernet based controllers.

# Firewall configuration written by system-config-securitylevel
# Manual customization of this file is not recommended.
*filter
:INPUT ACCEPT [0:0]
:FORWARD ACCEPT [0:0]
:OUTPUT ACCEPT [0:0]
:RH-Firewall-1-INPUT - [0:0]
-A INPUT -j RH-Firewall-1-INPUT
-A FORWARD -j RH-Firewall-1-INPUT
-A RH-Firewall-1-INPUT -i lo -j ACCEPT
-A RH-Firewall-1-INPUT -p icmp --icmp-type any -j ACCEPT
-A RH-Firewall-1-INPUT -p 50 -j ACCEPT
-A RH-Firewall-1-INPUT -p 51 -j ACCEPT
-A RH-Firewall-1-INPUT -p udp --dport 5353 -d 224.0.0.251 -j ACCEPT
-A RH-Firewall-1-INPUT -p udp -m udp --dport 631 -j ACCEPT
-A RH-Firewall-1-INPUT -p tcp -m tcp --dport 631 -j ACCEPT
-A RH-Firewall-1-INPUT -m state --state ESTABLISHED,RELATED -j ACCEPT
-A RH-Firewall-1-INPUT -m state --state NEW -m tcp -p tcp --dport 22 -j ACCEPT
-A RH-Firewall-1-INPUT -p udp -m udp --dport 67 -j ACCEPT
-A RH-Firewall-1-INPUT -p udp -m udp --dport 50000 -j ACCEPT
-A RH-Firewall-1-INPUT -j REJECT --reject-with icmp-host-prohibited
COMMIT

5. The additions to "/etc/sysconfig/iptables" will require restarting the iptables service.

$ su -c '/sbin/service iptables restart'
Password:
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Installing GalilSuite 1.0.2 on Ubuntu 12.04

Install GalilSuite Software Package
This section covers the installation of the GalilSuite 64 bit software package. After installing the GalilSuite software package, additional
configuration may be necessary. Any previous installations of GalilSuite must be removed before installing the latest version.

Before using a PCI controller, the GalilSuite PCI driver must be installed.
If Ubuntu has a firewall running, before using an Ethernet based controller, the firewall must be modified.

This document will outline the complete setup of GalilSuite for any or all controller communication interfaces.

1. Open a terminal by clicking Applications>Accessories>Terminal.
2. Get the Galil public key and import it into the package manager.

$ wget http://www.galilmc.com/support/downloads/software/galilsuite/linux/galil_public_key.asc
$ gpg --no-default-keyring --keyring trustedkeys.gpg --import galil_public_key.asc 

3. Get the GalilSuite package and install it with the package manager.

$ wget http://www.galilmc.com/support/downloads/software/galilsuite/linux/galilsuite.x86_64.deb
$ sudo dpkg -i galilsuite.x86_64.deb
Password:

4. GalilSuite can be launched from the terminal with the command "galilsuite" or from the system application launcher under GalilSuite.

Install the GalilSuite PCI Driver
If GalilSuite is to be used with a PCI based controller, the GalilSuite PCI driver must be installed. If GalilSuite will not be used with a PCI based
controller, this section can be skipped. If the GalilTools PCI driver has been previously installed, it must be removed before installing the
GalilSuite PCI driver. While there is limited support for the GalilTools PCI driver in GalilSuite, it is strongly recommended that the GalilSuite PCI
driver is used with GalilSuite.

1. Open a terminal by clicking Applications>Accessories>Terminal.
2. Download the required packages for the build process.

$ sudo apt-get install build-essential autoconf automake autotools-dev dh-make debhelper devscripts fakeroot xutils lintian pb
uilder
Password:

3. Download the Linux PCI driver debian source control file and source file from the Galil website.

$ wget http://www.galilmc.com/support/downloads/software/galilsuite/linux/galilsuite-pci_1.0.2.dsc
$ wget http://www.galilmc.com/support/downloads/software/galilsuite/linux/galilsuite-pci_1.0.2.tar.gz

4. Extract the source and verify integrity of source package.

$ dpkg-source -x galilsuite-pci_1.0.2.dsc

5. Move the newly extracted source directory and build the driver.

$ cd galilsuite-pci-1.0.2 
$ dpkg-buildpackage -uc -b

6. Return to the parent directory where the deb installer file is located and install the deb installer file.

$ cd ..
$ sudo dpkg -i galilsuite-pci_1.0.2_amd64.deb 

Configure the Firewall
If a firewall is in place, two exceptions must be included in the firewall settings.
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1. Accepting UDP traffic on port 67 allows GalilSuite to find and assign IP addresses to Ethernet based controllers.
2. Accepting UDP traffic on port 50000 allows for the connection to Galil controllers over Ethernet

For more information on setting up the firewall for use with GalilSuite, please see the GalilSuite documentation for Red Hat 5.8 or contact Galil
Applications support.
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